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Uvod

Hvala Vam na odabiru Vip e-SMS-a. Vip e-SMS dopunjuje Va$ Microsoft® Outlook® s funkcijama SMS i MMS

poruka. Time komunikacija postaje jednostavnija i zabavnija, bez obzira na to koristite li ga u uredu ili kod kuce.

Ovaj vodi¢ ¢e Vam pomo¢i kod prvog susreta s Vip e-SMS-om, od instalacije do upoznavanja s ve¢inom opcija.
Ako koristite operativni sustav Windows Vista, brojke prikazane u ovoj dokumentaciji mogu biti blago razliCite i
mozda ¢e Vam operativni sustav postaviti dodatna sigurnosna pitanja o tome zelite li nastaviti ili ne s

izvodenjem razliitih postupaka.

1 Instalacija i zahtjevi

1.1 Zahtjevi

Vip e-SMS ima sljedec¢e zahtjeve za ispravan rad:

Sto Komentar
Internet Pristup Internetu
Operativni sustav Microsoft Windows 2000, Windows XP ili Vista s posljednjim servisnim

paketima (Service Pack) instaliranim.

Outlook Jedna od sljedecih inadica Outlook-a instalirana:
e Qutlook 2000

e Outlook XP

e Outlook 2003

e Outlook 2007

MS Outlook mora biti Va$ zadani e-mail klijent.
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1.2 Podrska za Unicode

Vip e-SMS koristi hrvatski kao svoj lokalni jezik. To znaci da pojedina slova mozda nece biti ispravno
prikazana ako Regionalne i jezicne mogucnosti («Regional and Language Options») nisu
postavljene sukladno tome. Ako hrvatska slova nisu ispravno prikazana u Vasoj Vip e-SMS aplikaciji,
promijenite Regionalne postavke VaSeg racunala tako da otvorite Upravljacku plocéu («Control
Panel») i dvaput kliknite na Regionalne i jezicne mogucénosti («Regional and Language Settings»).
U prozoru koji se pojavi kliknite na karticu Dodatno («Advanced») i odaberite Hrvatski («Croatian») iz

padajuceg popisa jezika (vidi sliku ispod).

Regional and Language Options

Regional Options | Languages | Advanced

Language for non-Unicode programs

Thig zpstem zetting enables non-Unicode programs to display menus
and dialogs in their native language. It does nat affect Unicode
programs, but it does apply to all users of this computer.

Select a language to match the language version of the non-Unicode
programs you want bo use:

Coatin |4
Code page conversion tables

[ 10007 (MAL - J apanese] |
[] 10002 (MAC - Traditional Chinese Big5)

[] 10003 (MAL - Korean)

[] 10004 (MAC - Arabic)

[] 10005 (MAC - Hebrew] v

Drefault user account zettings

[]&pply all settings to the current user account and ta the default
uzer profile

[ Ok ] [ Cancel

1.3 Instalacija

Ukoliko imate raniju inacicu Vip e-SMS-a instaliranu na VaSem racunalu, istu morate prvo deinstalirati.

Za informacije o deinstalaciji programa upucujemo Vas na poglavlje Deinstalacija.

Ukoliko koristite Microsoft® Outlook®, vazno je da zatvorite sve Outlook® prozore prije instaliranja Vip

e-SMS-a.

Pronadite instalacijsku datoteku i kliknite dvaput na nju radi pokretanja instalacijskog programa. Imajte

na umu da se ime te datoteke moze razlikovati; po potrebi, provjerite s administratorom Vaseg sustava.

®

Vip-e-5M5-Outlook-4-,..
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1.4 Instalacijski vodié

Kod pokretanja instalacije bit ¢e prikazan pocetni dijaloski okvir.

- Wip e-SMS Outlook Instalacija (=]

Dobrodosli u instalaciju programa
Vip e-SMS Qutlook

Instalacija programa vip e-SMS Outlook na Vage rafunsle
sasta)l ze od nekolka jednostavnih karaks kraz koje te vas
provesti avaj éarcbnjok.

Preporutama zatvaranje svih ostalih aplikaciia prije samag
pocetia instalaciie. To e omoguéiti nadogradniu nekih
sistemshih datoteka bez potrebe 2a ponovrim pokretanjen
Vageq ratunala, U svakom trentku instalaciu modete
prekinuti pritiskom na ‘Odustani .

Za nastavak odaberite 'Dalje’.

Potvrdite da Zelite instalirati Vip e-SMS klikom na Dalje.

Zatim ¢e od Vas biti zatrazeno da prihvatite Licencni ugovor. Ukoliko ste suglasni s uvjetima, oznacite

Va$ odgovor klikom na Prihvaéam uvjete licencnog ugovora.

Potvrdite odabir klikom na Dalje.

< Yip e-SMS Outlook Instalacija EE&

Licencni ugovor
Molima progitajke licencu prije instalaciie programa Yip e-5M3 Outlook. '-&

'Page Down' 23 ostatak icence.

LGOAMOR O LICENCT 24 SOFTVER ~

MOLIMO PAFLINO PROCITAITE OAJ UGOWOR O LICEMCT PRIJE PREUZIMANIA TLT
KORISTENIA SOFTVERA,

KLIKOM M GUME :PPJHVACAM), OTVARANIEM AM?ALAZEJ PREUZIMANIEM
IPROTZY0NA TIT KORTSTFMTFM OPRFMF KOTA SADRFT OWATPROTZYON. 5116l ASNT STF

Ukolika pribvatate uviete licence, odaberite pryvu donju opciju. Morate pribvatiti licencu za
instalaciiu programa Yip e-5MS Outlook, Za nastavak odaberite ‘Dalje’.

(33 Pritvatam uviete licencnog ugavora
() Ne prihwacam uviete licencnog ugovora

[ < Nazad ” Dalie = I [ Odustani ]

Ako posjedujete administratorska prava za Va$e racunalo, otvorit ¢e se sljedeéi prozor. Ovdje mozete

odrediti Zelite li instalirati Vip e-SMS za sve korisnike ra¢unala ili isklju¢ivo za vlastito koristenje.

Potvrdite odabir klikom na Dalje.

- Vip e SMS Outlook Instalacija =3

Vista instalacije
Odaberite vrstu instalacije &

ko odaberete opciiu za sve karisnike, svaki korisrik morat ¢ registrirati svo broj
mabitzla,

Zelite li instalirati ovaj program samo za vlastita karigtenje il za sve korisnike na ovome:
ratunalu?

(3 za sve korisnike

() 5amo za wlastito korigtenje

Instalacijski program otkrio je daimate Administratorsica prava,

[ <nazad | _pabe> | [ odostan |

U sljede¢em prozoru mozete promijeniti mapu za instalaciju Vip e-SMS-a. Ako Zelite promijeniti mapu,



<

kliknite na Pregledaj i odaberite odrediSnu mapu.

Potvrdite odrediSnu mapu klikom na Instaliraj.

< Vip e-SMS Outlook Instalacija =13

Odaberite odrediste za instalaciiu
Odaberite mapu U koju Selite instalirati program Yip &-3M5 Cutlock, &

Pragram Yip &-5MS Outlook bit Ce instaliran u slisdecu mapu, Za instalaciiu na drugo odredite
odaberits ‘Pregleds i oznatite drugu mapu. 2a pofetak instaladie odaberite ‘Instali's

Odrediina mapa

Pregledaj...

Potrebno prostora na disku: 9.3V
Slobodno prostora na disku: 10.568

<Mazed |[_instaliai | [ odustani

Instalacijski program sada instalira Vip e-SMS na VaSe radunalo. To ée potrajati nekoliko sekundi. Po

zavrS$etku instalacije, kliknite na Kraj i spremni ste za registraciju rauna za koristenje usluge.

1.5 Registracija

Kod prvog pokretanja programa Microsoft® Outlook® nakon instalacije Vip e-SMS-a otvorit ¢e se
Carobnjak pomoéu kojega éete moéi otvoriti korisni¢ki radun.
Izgled carobnjaka Otvori radun moZe se razlikovati od ovog primjera. Kako biste nastavili s

registracijom, trebate unijeti Vas broj mobitela. Broj unesite u obliku 091xxxxxxx.

Carobnjak za postavke racuna

Otvori ratun .
Carobniak ée vam pomadi okvoriti raun, '&

K.ako biste maogli slati SMS i MMS poruke, trebate obvariti raéun.

MiZe upisite broj mobitela uz koji 2elite otvoriti rafun.
Broj unesite u obliku 09 Lo

Broj mobitela:

0911234567

Nakon $to ste unijeli broj mobitela, kliknite na Dalje.
Program sada provjerava podatke koje ste unijeli s posluziteliem. Na broj mobitela koji ste unijeli primit
¢ete SMS poruku koja ¢e sadrzavati registracijski kdd. Program ¢e traziti od Vas unos tog kdda. Unesite

registracijski kod i kliknite na Zavrsi.



('Zarubnjak Za postavke racuna

Provjera valjanosti
Provjera ispravnosti broja mobitela,

®

Reqistracijski kid je poslan na wa mobitel. Dobit éete ga u najkracem
magucern roku, Mife upisite dobiveni registracijski kid kako biste dovwrZili

reqgistraciju.

Registracijski kid:

Registracijski kid je poslan na braj mabitela 38591

[ g251

[ < Matrag ][ Zavrsi

] [ Odustani ]

Sada je Vas$ racun otvoren i mozZete poceti koristiti Vip e-SMS za slanje SMS i MMS poruka.

1.6 Deinstalacija

Prije deinstalacije prvo provijerite da je Microsoft® Office® zatvoren.

U izborniku Start («Start Menu») odaberite Postavke («Settings») te Upravljacka plo¢a («Control Panel»).

Otvara se Upravljacka plo¢a («Control Panel»).

| —
@ nternet Explorer
8] Microsoft Office Dutlook
|®] Launch Microsoft Office O...

) ™ Documents

5 My Recent Documents

) My Pictures

& wicrosoft office PowerPoint 2.
J My Music

3] microsoft office Excel 2003

B Motepad ¢ Favorites
() Outlook Express

18 My Computer
Y pant

&) ry Network Places

L& Adobe Reader 6.0
B adobe Frotoshop 6.0
& Caleulator

2y Printers and Faxes

o

..

AllPrograms [

& Control Panel EIEX

Fie Edt Vew Fovoies Toos Heb ar

Doek - © < @ | Psomch racers | -

#dcress | B Control Panel ~

- Controtanel B

B Swiehta Cateoery Vew

See Also (24

2

InelR)
Exe.

2 e

Dispay  Folder Optens Game
Contrllers

R Windos Updte

P L = D D @

5 2 ()
- 4 = 7
s vt S e i
2 8 &

em Tackbara
Lvelpdste St e

"=

Powe Optons  priters snd
Fares

Prikazuje se dijaloSki okvir s popisom svih

instaliranih programa prikazanih po abecednom redu. Kliknite na



redak na kojemu pise Vip e-SMS Outlook.

i
&
Change or
e

Add lew
Programs

AddjRemove
windows
Components

Sek Pragram
Access and
Defaults

1 Add or Remove Programs

Programs

Curvertly installed programs and updates: Show updates Sortby: [ame

.
 ¥p &5 Desktop See 6,858

- ¥ip e-5MS Dutlook

“odafone Mobile Connect Lite

Sie 26,748
{5) 4P Client Size  11,80MB
& Webshots Deskcop Size  BBME
5] Windows Genuine Advantage Validation Tool (KBS32130) Installed On 11,03,2008

'8 Windows Installer 3.1 (KEB93803)

{8 vinchows Tnternet Explorer 7 See 2,718
(@ Windows Inkernet Explorer 7 - Softwere Updates
& security Update for windows Intermet Explorer 7 (KB938127) Installed On 11.03.2008
(6 Security Update For Windaws Internet Explorer 7 (KB939653) Installed O 26.09.2008
() windows Media Format 11 runtime Se  7,95MB
@) Windows Pesia Flayer 11 Ses 7,98

12 Windaws 5P - Scftwere Updates
A Security Updats: for Windows KP (KBGI0046) v

Redak ¢e se pro8iriti i bit ¢e prikazane dodatne informacije o programu. Kliknite na gumb Ukloni («<Remove») i

potvrdite Vasu Zelju da uklonite program. lzgled dijaloskog okvira Dodaj/Ukloni programe («Add/Remove

Programs») moze biti neSto drugaciji na VaSem racunalu ovisno o inacici Windows-a koju posjedujete.

2

SMS poruke

2.1 Slanje SMS poruka

2.1.1 Pristup prozoru SMS-a

Za izradu SMS poruke, otvorite prozor Novi SMS. To moZete uciniti na vise nacina, evo primjera:

e U Outlook-u, kliknite na gumb Novi SMS na alatnoj traci:

Inbox - Microsoft Outlook

I Fle Edit Mew Go  Tools
Padnew - | o 23 X | CaE

| A Movi SMS | ke Movi Mg |

Izradi novu SMS poruky
Favorite FOders

L Inbox,

L3 unread mMail
[ For Follow Up
[I=4 Sent Ttems

e Kiliknite na gumb New («Novi») na alatnoj traci Outlook-a te u padaju¢em popisu odaberite

Novi SMS

e  Odaberite Tools -> Vip e-SMS -> Novi SMS («Alati -> Vip e-SMS -> Novi SMS ») u glavnom

izborniku Outlook-a.
e  Odaberite File -> New -> Novi SMS («Datoteka -> Novo -> Novi SMS »)

e Odaberite Actions -> Novi SMS («Akcije -> Novi SMS »)
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2.1.2 Odabir primatelja

U polje pored gumba Prima unesite broj mobitela na koji Zelite poslati poruku. Format broja moze biti
proizvoljan. Ako SMS poruku Zelite poslati na broj mobitela iz inozemne mobilne mreze, broj mora biti

unesen u medunarodnom formatu sa znakom «+» ispred pozivnog broja zemlje.

Datoteka Uredi Alati Poruka  Pomod

@rotalii [, & & o vip
0911234567;|

S alie: +38591 K
Znakavi: o[1] Ukupno: 15M5

Ako Zelite poslati poruku veéem broju primatelja, mozete unijeti viSe brojeva mobitela. Brojeve tada

razdvojite tockom-zarezom ili zarezom.

Mozete takoder odabrati primatelja iz Vaseg Microsoft® Outlook® adresara. U tu svrhu kliknite na gumb
Prima ili odaberite Alati -> Imenik u prozoru Novi SMS. Otvara se dijaloSki okvir s Vasim kontaktima u
kojemu mozete odabrati jedan ili viSe kontakata za primatelje ove SMS poruke. MoZete takoder odabrati

grupe primatelja (distribucijske liste).

Dodavanje imena i broja mobitela primatelja mozZete obaviti brze na jedan od sliede¢a tri nacina:

napisite prvo slovo ili prva slova imena te pritisnite Tab ili Ctrl+K ili gumb Provjeri imena.

NAPOMENA: Kontakti bez adrese e-poste nece biti prikazani na popisu kada pritisnite Ctrl+K.

2.1.3 Unos poruke

Unesite poruku u veliki prostor ispod polja Salje.
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= Novi SMS
Datokeka  Uredi  Alati Poruka  Pomod

@rosalii [ & & @

& alie [+38531

Sastanak je odgoden za sutra u14:00, 2oha &, | kat
Hevala svima -]

Znakovi: 67 [1]

Ukupno:

15M3

<

Vip e-SMS poruka moze se sastojati od najvise 765 znakova (duzina 5 Vip e-SMS poruka). Poruka

duza od 160 znakova bit ¢e poslana kao nekoliko povezanih Vip e-SMS poruka

Broj znakova i broj poruka koje ste napisali bit ¢e prikazani u traci stanja na dnu prozora.

2.1.4 Slanje poruke

Kliknite na gumb Posalji za slanje poruke.

2.2 lzbornik Alati u Outlook-u

Nekoliko funkcija u Vip e-SMS-u, poput izrade nove SMS ili MMS poruke i Opcija dostupne su iz

izbornika Tools («Alati») u Outlook-u.

.
1 E-mail Accounts. .. Statuls upldaite -
| eMMS Outlook 4 || Mew SM3
Ciptions. .. Mew MM3
H o Marc (+44 .. Options. ..
o Marc (+44 ..

4 Anders Eriksson

2.3 Izbornik Alata za SMS

05 Message  Help

Address Boak... Ctrl+shift+8
Edit: Templates. ..
Edit: Signature [

Check Mames Chrl+K

Options. ..

U svakom prozoru Novi SMS ili Poslani SMS nalazi se izbornik Alati koji sadrzi nekoliko naredbi koje
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su specificne za Vip e-SMS. Te naredbe su sljedece:

Imenik — Ova naredba otvara Va$ Outlook adresar i omoguéuje Vam da u njemu odaberete primatelje

SMS poruke koju sastavljate.
Uredi predloske — Ova naredba Vam omogucuje stvaranje predloZaka i upravljanje njima.

Uredi potpise — Ova naredba Vam omogucuje da uredite potpis koji sustav automatski dodaje u SMS
poruke koje sastavljate.

Provjeri imena — U polje Prima mozete unijeti prva slova imena primatelja koji postoji u Vasem
Imeniku («Address Book») te nakon toga koristiti ovu naredbu za umetanje tog kontakta, tj. unoSenje
broja mobitela u polje Prima. Ovoj funkciji mozete takoder pristupiti pritiskom na Ctrl+K ili klikom na

gumb a‘ na alatnoj traci u prozoru Novi SMS.

Opcije — Ova naredba otvara prozor Opcije kako biste mogli pregledati i urediti opcije koje su

pridruzene Vasem korisnickom rac¢unu.

2.4 Raspored slanja poruka

Vip e-SMS Vam omogucuje da odredite raspored slanja poruka radi njihove kasnije isporuke. To
mozete uginiti klikom na gumb 'I u bilo kojem prozoru Novi SMS ili odabirom Poruka -> Raspored

slanja. Otvara se prozor Raspored slanja poruka.
v x|

Opciie isporuke

99 (%) Podalji ndmah
Ig 9

) Podaljiu

Ovaj prozor nudi dvije opcije: Posalji odmah i Posalji u. Opcija Posalji odmah unaprijed je odabrana;
SMS poruka ¢e biti poslana ¢im kliknite na gumb Posalji u prozoru Novi SMS. Ako Zelite odrediti
kasnije vrijeme isporuke poruke kliknite na opciju Posalji u te koristite polja za datum i vrijeme kako

biste odredili vrijeme kada bi poruka trebala biti poslana.

Kada zavrsite, kliknite na OK da spremite sve promjene koje ste unijeli u taj prozor ili kliknite na Cancel

(«Ponisti») ako zelite odustati od Vasih promjena.

2.5 SMS Podsijetnici

Prigodom stvaranja obveze (Appointment, Meeting) u kalendaru Outlook-a za koju ste omogucdili

funkciju podsjetnika, mozete odabrati da podsjetnik takoder primite u obliku SMS poruke. Funkcija

SMS podsjetnika dostupna je korisnicima programa Outlook 2003 sa servisnim paketom 2 (Service

Pack 2) ili novijeg programa (nije dostupna korisnicima programa Outlook 2000).
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2.5.1 Aktiviranje funkcije podsjetnika

Funkcija podsjetnika je jedino na raspolaganju ako je aktivirana u kartici Opéenito prozora Opcije.

General | account | SMS MMS | Scheduling | Alerts
SM3 Reminders

@ Ackivate the SMS reminder functionality
[ Fallows Qutlaok@'s reminder by defaulk

Napomena: Kartica Opcenito nije dostupna korisnicima programa Outlook 2003 sa servisnim paketom

1 (Service Pack 1) ili ranijim.

2.5.2 Postavljanje podsjetnika za obvezu
Na alatnoj traci obveza (Appointment, Meeting) u Outlook-u nalazi se novi gumb s oznakom SMS
podsjetnik aktiviran ili SMS podsjetnik deaktiviran. Ako zelite primiti podsjetnik putem SMS-a za

obvezu, samo provjerite da je oznaka gumba SMS podsjetnik aktiviran.

i File Edt Wiew Insert For

} | saveand diose | = 1 | 4

| & 515 Reminder On |=

Appointment - 5MS Reminder On

Subject: Sales Meeting

Location:

SMS podsijetnik ¢e biti poslan u isto vrijeme koje je odredeno za podsjetnik u Outlook-u, a poruka ¢e
sadrzavati onoliko informacija o obvezi koliko moze stati u jednu SMS poruku.

Reminder: |15 minutes w

SMS podsjetnik za obvezu bit ¢e poslan u sljede¢im prigodama ako se obveza nalazi 30 ili viSe
minuta od vremena postavljanja podsjetnika za obvezu:
¢ Prigodom postavljanja obveze u Kalendaru (koja se ponavlja/koja se ne ponavlja)

¢ Prigodom prihvac¢anja poziva u Kalendaru (koji se ponavlja/koji se ne ponavlja)

Napomena: prigodom promjene pojedinosti, uklanjanja obveze ili odbijanja poziva, Vip e-SMS
nastoji promijeniti na najbolji nac¢in SMS podsjetnike sukladno tome. Nije zajam¢eno da ¢e se

promjene u Kalendaru Outlook-a odraziti u trenutku slanja poruke.

Kao i u sluéaju poruka s odredenim rasporedom slanja (vidi odjeljak Raspored slanja poruka), SMS
podsjetnik pohranjuje se na srediSnjem posluzitelju za poruke u svrhu isporuke u primjereno vrijeme,
kao i u Vasu mapu Odlazni SMS/MMS.

Ako niste spojeni na posluzitelj u trenutku postavljanja podsjetnika, primit ¢ete obavijest koja Vas na
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to upozorava. Podsjetnik ¢e biti pohranjen u mapi Odlazni SMS/MMS, a Vip e-SMS ¢e i dalje

pokuSavati uspostaviti vezu s posluziteljem i poslati poruku posluzitelju kako bi je on mogao pohraniti.

Napomena: Ako Vip e-SMS ne uspije uspostaviti vezu s posluziteliem za poruke prije

zakazanog vremena slanja podsjetnika, SMS podsjetnik nec¢e biti poslan.

Napomena: Prigodom postavijanja obveze koja se ponavlja, SMS podsjetnik bit ¢e stvoren
jedino za prvu obvezu. Naknadni SMS podsjetnici bit ¢e stvoreni prigodom generiranja
podsjetnika za obvezu i kada korisnik odbije (,,Dismiss”) ili stavi obvezu na cekanje
(--Snooze“).

3 MMS poruke

3.1 Slanje MMS poruka

Ako Zelite izraditi MMS poruku, otvorite prozor Novi MMS. To mozete u€initi na viSe nacina.

¢ U Outlook-u, kliknite na gumb Novi MMS na alatnoj traci:

Inbox - Microsoft Outlo|

i Fle Edit Yew Go To
Padbew - | 3 X
A hew SMS |Q Mew MMS|

Mew M

Favorite Folders

| Inbox ()

| Liread Maf

| For Folow Lp
=] Sent Tkems

Kliknite na gumb New («Novi») na alatnoj traci Outlook-a te u padaju¢em popisu odaberite Novi MMS

e Odaberite Tools -> Vip e-SMS -> Novi MMS («Alati -> Vip e-SMS -> Novi MMS ») u glavhom

izborniku Outlook-a.
e  Odaberite File -> New -> Novi MMS («<Datoteka -> Novo -> Novi MMS »)

e Odaberite Actions -> Novi MMS («Akcije -> Novi MMS »)

Otvara se prozor Novi MMS.
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Funkcije za upravljanje kontaktima (Imenik, grupe, itd.) koje su opisane su pod naslovom Slanje SMS

poruke takoder vrijede kada Saljete MMS poruku.

3.2 Jednostavni MMS

U prethodnom odjeljku prikazan je Jednostavni MMS - za slanje MMS poruka na jednoj stranici.
Mozete takoder odabrati Napredni MMS, koji Vam omogucuje sastavljanje i slanje MMS poruka na vise
stranica. Ako se prozor Novi MMS otvori kao Napredni MMS, mozete prijeéi na slanje Jednostavnog
MMS-a odabirom Pregled -> Jednostavni MMS u glavnom izborniku prozora Novi MMS. Idu¢i put
kada otvorite prozor Novi MMS, sustav ¢e pamtiti posljednji koriSteni nacin rada i otvorit ée novi prozor

u tom nacdinu rada.

NAPOMENA: Na svakoj stranici MMS poruke moZete dodati slikovnu ili zvukovnu datoteku (ili obje) ili
moZete dodati video datoteku. Ne moZete kombinirati video datoteku i slikovnu datoteku ili zvukovnu

datoteku. Ukoliko to pokusSate uciniti, dobit ¢ete poruku potvrde sliénu ovoy:

eMMS Outlook

[} Adding a wideo clip will remove audio and image From this page.
- Do you wank ko conkinue?

Ako zelite dodati novu datoteku (i ukloniti druge datoteke kako je naznaceno), kliknite na OK («U

redu»). Ako Zelite izbje¢i dodavanje nove datoteke i uklanjanje drugih datoteka, kliknite na Cancel
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(«Ponisti»).

NAPOMENA: Kada dodate multimedijsku datoteku u MMS poruku, ona ce biti kodirana u Base64/ASCI|
kodu, koji prouzrokuje povecanje njezine velicine za 30 do 40%. Primjerice, dodavanjem zvukovne
datoteke cija je velicina u Windows-ovom podatkovnom sustavu 10 kB povecat ¢e se velicina MMS

poruke za 13 do 14 kB.

3.2.1  Umetanje slike

Vip e-SMS podrzava JPG, GIF i BMP formate slika. Ovisno o konfiguraciji Windows-a, mogu biti podrzani dodatni
formati poput TIFF, PNG, itd. Ako Zelite dodati nepokretnu sliku u Vasu MMS poruku, koristite jedan od sljedecih

postupaka:

e Kiliknite na iumb Umetni sliku u gornjem lijevom dijelu prostora za pregled medija.

File Edit View Media

& send :ﬂ & &

Subject:

EAE-E

e U glavnom izborniku prozora Novi MMS odaberite Mediji -> Umetni sliku.

Vip e-SMS otvara standardni Windows prozor za odabir datoteke omoguc¢uju¢i Vam time pronalazak i odabir

slikovne datoteke koju Zelite umetnuti.

Povlacenje i ispustanje (,Drag and drop”) slikovnih datoteka podrzano je na razli¢itim mjestima u MS Windows:
na radnoj povrsini (Desktop-u), u Internet Explorer-u, Windows Explorer-u, itd.

Povucena slika mora biti postavljena u prostor za pregled medija.

3.2.2 Promjena velicine slika
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File Edit Yiew Media

@ 4 @ ¥

U glavnom izborniku prozora Novi MMS odaberite Poruka -> Opcije slike. Otvara se prozor Opcije slike.

Image Size

al
=

Small [128x128) Medium [200x300) Large (480x640)
Image Quality
QL

% ]

Low (smaller message] High [larger message)

Pomocu kliznog izbornika Veli¢ina slike postavite maksimalnu veli€inu slike koju zelite poslati u Vasoj poruci.
Ako je slikovna datoteka koju ste odabrali za slanje veca od veli€ine koju postavite ovdje, datoteka ce biti
smanjena na ovu veli¢inu. Ako je manja, veli¢ina datoteke nece biti smanjena; slika ¢e zadrzati svoju izvornu

veli¢inu.

NAPOMENA: Veli¢ina slike koja je veéa od odabrane maksimalne veli¢ine bit ¢e promijenjena tako da bude

prilagodena odabranoj maksimalnoj veli¢ini. Omjeri ¢e biti zadrzani tako da slika ne bude iskrivljena.

Primjeri:

e Ako ste za maksimalnu veli€¢inu odabrali Mala (128x128) i ako dodate sliku od 400x200 piksela, slika ce
biti smanjena na 128x64.

e Ako ste za maksimalnu veli¢inu odabrali Velika (480x640) i ako dodate sliku od 400x200 piksela,
veli¢ina slike nece biti promijenjena — prilagodena je Velikoj veli¢ini bez promjene veli€ine.

e Ako ste za maksimalnu veli¢inu odabrali Velika (480x640) i ako dodate sliku od 800x400 piksela, slika
¢e biti smanjena na 640x320 piksela (radi zadrzavanja omjera kada je duZzina slike dva puta veca od
njezine Sirine; 640x320 je najveca veli¢ina slike takvih omjera koja ¢e biti prilagodena za 480x640
piksela).

e Ako ste za maksimalnu veli¢inu odabrali Velika (480x640) i ako dodate sliku od 800x800 piksela, slika
¢e biti smanjena na 480x480 piksela. (Slika mora biti zadrzana kao kvadrat, a 640x640 ne bi bilo

prilagodeno Velikoj velicini; 480x480 je najveci kvadrat koji je prilagoden.)

Pomocu kliznog izbornika Kvaliteta slike postavite razinu kvalitete slike koju ¢ete poslati u Vasoj poruci. Pri
tome postoji kompromis izmedu kvalitete i veli¢ine datoteke: veéa kvaliteta daje ostrije i privlacnije slike ali i vece
datoteke, $to znaci da ¢e poruka biti veéa i da ¢e viSe podataka biti proslijedeno preko mreze kada poSaljete

poruku (kod slanja MMS-a ne napla¢uje se GPRS promet). U prozoru Novi MMS prikazana je slika u odabranoj
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veli¢ini i kvaliteti te moZete vidjeti kako bi trebala izgledati primatelju.

NAPOMENA: Mobilna mreza dodatno mijenja veli¢inu slika radi njihovog prilagodavanja zaslonu mobilnog

telefona primatelja te stoga nema jamstva da ée primatelj doista vidjeti ono $to Vi vidite u prozoru Novi MMS.
NAPOMENA: Sve slike ¢e biti pretvorene u JPG prije njihovog slanja. Animirani GIF nije podrzan.

3.2.3 Brisanje slike

Ako Zelite izbrisati odabranu sliku iz VaSe MMS poruke, postupite na jedan od sljede¢ih nacina:

Kliknite na gumb lIzbrisi sliku u gornjem lijevom dijelu prostora za pregled medija:

¥ New MMS - eMMS O
File Edit Yiew Media T

@JSend :U{J& [

I\.
Delete Image h

e U glavnom izborniku odaberite Mediji -> Izbrisi sliku.

3.2.4 Umetanje video isjecka

Vip e-SMS podrzava 3GP format video datoteke. Ako Zelite umetnuti video u Vasu MMS poruku, postupite na
jedan od sljedec¢ih nacina:

Kliknite na gumb Umetni video u gornjem srednjem dijelu prostora za pregled medija

U glavnom izborniku prozora Novi MMS odaberite Mediji -> Umetni video.

¥ New MMS - eMMS Outlook
File Edit ‘iew Media Tools Messac

@send 4l @ & W

Subject;

e B ECf. (]

Povlagenje i ispustanje (,Drag and drop”) video datoteka podrzano je na razli¢itim mjestima u MS
Windows: na radnoj povrSini (Desktop-u), u Internet Explorer-u, Windows Explorer-u, itd.

Povuéeni video mora biti postavljen u prostor za pregled medija.
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Vip e-SMS otvara standardni Windows prozor za odabir datoteke omoguc¢uju¢i Vam time pronalazak i odabir

videa koji zelite umetnuti.

3.2.,5 Brisanje videa

Ako Zelite izbrisati video isjecak iz Vase MMS poruke, postupite na jedan od sljedec¢ih nacina:

¢ Kiliknite na gumb lIzbrisi video u gornjem srednjem dijelu prostora za pregled medija:

¥ New MMS - eMMS Outlook

File Edit VYiew Media Tools Message

@snd 4l @ ¥ @

Subject:

Delete Yideo Clip

e U glavnom izborniku prozora Novi MMS odaberite Mediji -> Izbrisi video.

Video je izbrisan iz MMS poruke. Ako Zelite, mozete tada ponovno odabrati neki video koji zelite umetnuti.

3.2.6 Reprodukcija videa

Ako Zelite reproducirati video isjeak koji ste odabrali, postupite na jedan od sljede¢ih nagina:

¢ Kliknite na gumb Prikazi video u gornjem srednjem dijelu prostora za pregled medija:

¥ New MMS - eMMS Outlook

File Edit View Media Tools Message Help

@i 4 @ ¥ @

Subject:

2R B89 D &

¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Prikazi video.

Za reprodukciju video isjecka potreban je softver za reprodukciju koji podrzava format 3GP, npr. Real Player.

Ako je na Vasem racunalu instaliran potreban softver, Windows ¢e otvoriti prozor softvera za reprodukciju videa i

reproducirati video isjecak.

18 (26)



<
Ilt

3.2.7 Umetanje zvuka

Vip e-SMS podrzava MIDI, AMR i WAV formate zvuka. Zvukovnu datoteku moZete umetnuti u Vasu MMS poruku

na jedan od sljedeéih nacina:

¢ Kliknite na gumb Umetni zvuk u gornjem desnom dijelu prostora za pregled medija

e U glavnom izborniku prozora Novi MMS odaberite Mediji -> Umetni zvuk.

¥ New MMS - eMMS Outlook

File Edit Wiew Media Tools Message Help

@ 4 Q@ ¥

Subject:

j”@ﬁ@da"fa’ Ha

Insert Sound...

Povlacenje i ispustanje (,Drag and drop”) zvukovnih datoteka podrzano je na razli¢itim mjestima u MS Windows:
na radnoj povrsini (Desktop-u), u Internet Explorer-u, Windows Explorer-u, itd.

Povucena zvukovna datoteka mora biti postavljena u prostor za pregled medija.

Vip e-SMS otvara standardni Windows prozor za odabir datoteke omoguc¢uju¢i Vam time pronalazak i odabir

zvukovne datoteke koju zelite umetnuti.

3.2.8 Brisanje zvuka

Zvukovnu datoteku mozete izbrisati iz VaSe MMS poruke na jedan od sljede¢ih nacina:

¢ Kliknite na gumb Izbrisi zvuk u gornjem desnom dijelu prostora za pregled medija:

¥ New MMS - eMMS Outlook

File Edit Wiew Media Tools Message Help

@ 8l @ ¥ @

Subject:
anes e d&%& e

¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Izbrisi zvuk.

Zvukovna datoteka je izbrisana iz MMS poruke. Ako Zzelite, mozete tada ponovno odabrati neku zvukovnu

datoteku koju Zelite umetnuti.
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3.2.9 Reprodukcija zvuka
Zvukovnu datoteku koju ste umetnuli u VaSu MMS poruku mozete reproducirati na jedan od sljede¢ih nacina:

¢ Kliknite na gumb Pokreni zvuk u gornjem desnom dijelu prostora za pregled medija:

¥ New MMS - eMMS Outlook

File Edit Wiew Media Tools Message Help

@send 4l G & @

Subiject:
i S e T - [
I3

Flay Sound

¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Pokreni zvuk.

Za reprodukciju zvukovne datoteke potreban je softver za reprodukciju koji podrzava format odabrane zvukovne

datoteke, npr. Real Player. Windows reproducira zvukovnu datoteku u zasebnom softveru za reprodukciju.

3.3 Napredni MMS

Napredni MMS omogucuje Vam izradu i slanje MMS poruka na vise stranica. Po primitku Vase poruke,

stranice ¢e biti reproducirane na mobitelu primatelja prema redoslijedu kojim ste ih izradili u poruci.

Ako Zelite prije¢i na slanje Naprednog MMS-a, u glavnom izborniku prozora Novi MMS odaberite Pregled ->
Napredni MMS. Idu¢i put kada otvorite prozor Novi MMS, sustav ¢e pamtiti posljednji koriSteni nacin rada i

otvorit ¢e novi prozor u tom nacinu rada.

Kada koristite Napredni MMS, mozete obraditi svaku stranicu kako je opisano za Jednostavni MMS. U

ovom odjeljku su opisani samo dijelovi Naprednog MMS-a koji pruzaju funkcije za viSe stranica.
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B Mew MMS - eMMS Desktop
Filz Edit View Media Tools Meszage Help

@iend & £ W ot 0EMS
8 re.. |

Subiject:

B o @ e © 5 1L e Sound

Hao image o video

g & &
. 10 sec
Message size:. 2.1 KB Hassage length: 10 sec

Na dnu prozora nalazi se op¢i pregled stranica VaSe MMS poruke. Na gornjoj snimci zaslona, poruka ima samo
jednu stranicu, koja je duljine od 10 sekundi («10 sek» ispod ikone stranice).

NAPOMENA: Ova stranica ne moZe biti izbrisana jer svaka MMS poruka mora imati najmanje jednu stranicu; ako
pokusate izbrisati zadnju preostalu stranicu, dobit ¢ete poruku o pogresci.

Ako Zelite dodati sliku, video ili zvuk na stranicu, kliknite na tu stranicu radi njezinog odabira te postupite
kako je opisano pod naslovom Jednostavni MMS (prethodni odjeljak). Kada je neka stranica odabrana,
sredi$nji dio prozora funkcionira za tu stranicu poput prostora za pregled medija, na isti nacin kao kod

Jednostavnog MMS-a.

3.3.1 Dodavanje stranice

Ako Zelite dodati novu stranicu u MMS poruku, postupite na jedan od sljede¢ih nacina:

e Kliknite na gumb Dodaj stranicu u gornjem lijevom dijelu prostora za pregled stranica:
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¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Dodaj stranicu.

Nova stranica je dodana u MMS poruku i prikazana u prostoru za pregled stranica. Nova stranica se uvijek

dodaje na kraju MMS poruke.

3.3.2 Brisanje stranice
Postoje dva nacgina brisanja stranice iz MMS poruke:

e Kliknite na gumb IzbriS§i stranicu u gornjem lijevom dijelu prostora za pregled stranica.

B & B
I

i0s 10s

¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Izbrisi stranicu.

NAPOMENA: Ova mogucnost nije dostupna ako MMS poruka ima samo jednu stranicu.
NAPOMENA: Koju c¢ete stranicu izbrisati ovisi o tome koju ste stranicu odabrali klikom. Ako je neka stranica
odabrana, ta c¢e stranica biti izbrisana. Ako nije odabrana nijedna stranica, bit ¢e izbrisana posljednja stranica

MMS poruke.

3.3.3 Trajanje stranice
Ako Zzelite postaviti trajanje neke stranice (ij. trajanje reprodukcije stranice kada primatelj pregledava MMS

poruku), odaberite stranicu jednostrukim klikom te postupite na jedan od sljedecih nacina:

e Kliknite na gumb Trajanje stranice u gornjem lijevom dijelu prostora za pregled stranica:

"| Fage Duration

¢ U glavnom izborniku prozora Novi MMS odaberite Mediji -> Trajanje stranice.

Otvara se prozor Trajanje stranice.

Page Duration

% =
DRLEEE
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Ovdje duljinu u sekundama mozete izravno unijeti u polje koristeci tipkovnicu ili strelice uz polje za postavljanje

duljine. Kada ste zavrsili kliknite na OK.

NAPOMENA: Za koju ¢ete stranicu postaviti trajanje ovisi o tome jeste li odabrali neku stranicu klikom na nju.
Ako je neka stranica odabrana, trajanje te stranice c¢e biti promijenjeno. Ako nije odabrana nijedna stranica, bit ¢e
promijenjeno trajanje posljednje stranice MMS poruke (na to ukazuje sivom bojom istaknuto trajanje stranice koje

Jje vidljivo na gornjoj snimci zaslona prostora za pregled stranica, na kojoj je prikazan gumb Trajanje stranice.)

3.4 lzbornik Alati za MMS
Message Help

Address Book. ., Ctrl+Shift+E

Check Mames  Cerl+k

Opkions... I

U svakom prozoru Novi MMS ili Poslani MMS nalazi se izbornik Alati koji sadrzi nekoliko naredbi koje su

specificne za Vip e-SMS. Te naredbe su sljedece:

¢ Imenik — Ova naredba otvara Va$ Outlook adresar i omogucuje Vam da u njemu odaberete primatelje
MMS poruke koju sastavljate.

¢ Provjeri imena— U polje Prima mozete unijeti prva slova imena primatelja koji postoji u Vasem Imeniku
(«Address Book») te nakon toga koristiti ovu naredbu za umetanje tog kontakta, tj. unoSenje broja
mobitela u polje Prima. Ovoj funkciji mozete takoder pristupiti pritiskom na Ctrl+K ili klikom na gumb

&

e Opcije — Ova naredba otvara prozor Opcije kako biste mogli pregledati i urediti opcije koje su

na alatnoj traci u prozoru Novi MMS.

pridruzene Vasem korisni¢kom rac¢unu.

4 Mape poruka

4.1 Odlazne poruke

Poruke za koje ste odredili raspored slanja prikazane su u Va$oj mapi Odlazni SMS/MMS u Outlook-u. Poruke
za koje ste odredili raspored slanja i koje jo$ nisu poslane mozete vidjeti u kartici Raspored slanja u prozoru

Opcije.

o
o +46733964775 Don't Forget to update your forecast...
o 45712488699 Morning, can you please give me a ... ¢

b agTIneATIE [ VANV S

|4 zenc sz
[ Jent text messages
| utbo

[ ¥erzonden M=
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Isto tako, svi SMS podsjetnici koji su generirani u kalendaru pohranjeni su u mapi Odlazni SMS/MMS do
njihove isporuke. Svi SMS podsjetnici mogu se urediti na nacin da se otvori obveza (Appointment, Meeting) u

kalendaru.

Ako niste spojeni na posluzitelj u trenutku slanja poruke za koju ste odredili raspored slanja, dobit ¢ete
poruku upozorenja da niste spojeni i da ¢e poruka biti poslana kada budete ponovno spojeni. Zatim se
poruka pohranjuje samo u mapi Odlazni SMS/MMS. Vip e-SMS ¢e i dalje pokuSavati poslati poruku
posluzitelju za poruke.

NaPoMENA: Ako Vip e-SMS ne uspije uspostaviti vezu s posluZiteliem za poruke prije zakazanog vremena

isporuke poruke, poruka nece biti poslana.

Napomena: Ako je obveza iz kalendara (s podsjetnikom iz kalendara) premjestena, poruka moZe biti zaglavijena
u mapi Odlazni SMS/MMS. Poruka ce biti automatski uklonjena prigodom prvog iduéeg pokretanja Outlook-a 2

tiedna nakon vremena kada je izvorna poruka trebala biti poslana.

4.2 Pregled poslanih poruka

U popisu mapa («Folder List») VasSeg programa Microsoft Outlook postoji nova mapa pod nazivom Poslani

SMS/MMS. Sve SMS i MMS poruke koje ste poslali pohranjene su u toj mapi.

1] INDOX 2]

(3 Junk E-mail [13] o +46703030895 md 902
@ j Kund Hi John, call me when you land, BR. Marc
4 News (23) o +96703030895 to 03-10
(5| outbox [1] Mew Mail 2005-03-10 17:40 From Anders Hardeb. ..
=[] Partners h‘ +46703030598 on 03-09
[ Priv Mew Mail 2005-03-09 17:30 From Anders Hardeb, .
& [ ProdMgrit ) o 46703030898 an 03-09
B [ Sales BDM Marketing New Mail 2005-03-09 17:21 From Anders Hardeb...
L= Sent Ttems :
j Sont i i HH6703030898 ki 03-05
o . I =g Reminder 2005-03-09 10:00 Subject: Emil Oldberg
4 [ Search Folders :
- i HH6703030898 ki 03-05
Reminder 2005-03-08 09:00 Subject: Ring om kyl...
o +46703030895 m 03-07

Kliknite dvaput na poruku ako Zelite pregledati njezin sadrzaj. Otvorit ¢e se novi prozor sa sadrzajem poruke.

24 (26)



<
Ilt

T Sent SMS - cMMS Dullook
File Edt View Took Message Help

Ta Oy 0703305380

From: +~AETEFITT [Foeph to b
Serk 20051011 0350
Tast

Chewrachers ; 4[1] Totak  05M5

4.2.1 Provjera podataka o stanju poruke
Mozete provjeriti stanje isporuke poruke klikom na gumb Stanje isporuke na alatnoj traci. Tu mozete vidjeti, za

svakog primatelja, je li poruka poslanaili ne.

™ eMMS Outlook

Recipient Skatus
Grjan 070-3030598 Sent

Close

4.2.2 Prosljedivanje poslane poruke
Prethodno poslanu poruku mozete proslijedite jednom ili nekolicini primatelja. U mapi Poslani SMS/MMS
odaberite poslanu poruku koju biste zeljeli proslijediti te kliknite na gumb Forward (,Proslijedi”) u glavhom

prozoru programa Microsoft Outlook. MoZete takoder otvoriti poruku i pritisnuti gumb Proslijedi.
i adNew | % X | iaReply (@Reply to Al [ Forward]| (¥ SendfReceive ~ | ZoFind |

Favorite Folders

(7 Inbox (4
[ unread Mail (23)
[ For Follow Up [4]
[ sent Teems

Otvorit ¢e se prozor Novi SMS u kojemu ¢e se u polju poruke nalaziti izvorni tekst poruke.
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Fils Edt Took Messsge Help !

@sed [ & & o
(o)

From A4S TTECECTUT [Feply 1 et -
Test

Chewrachers ; 4[1] Totak 0505
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